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© Cypress Semiconductor Corporation, 2009-2011. The information contained herein is subject to change without notice.
Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a
Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted
nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an
express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components
in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user.
The inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such
use and in doing so indemnifies Cypress against all charges.

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by
and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty
provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create
derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom soft-
ware and or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as speci-
fied in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this Source
Code except as specified above is prohibited without the express written permission of Cypress.

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATE-
RIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials described
herein. Cypress does not assume any liability arising out of the application or use of any product or circuit described herein.
Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure
may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a life-support sys-
tems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all
charges.

Use may be limited by and subject to the applicable Cypress software license agreement.

PSoC® is a registered trademark of Cypress Semiconductor Corporation. All products and company names mentioned in this
document may be the trademarks of their respective holders.

Purchase of 12C components from Cypress or one of its sublicensed Associated Companies conveys a license under the
Philips I12C Patent Rights to use these components in an 12C system, provided that the system conforms to the I12C Standard
Specification as defined by Philips. As from October 1st, 2006 Philips Semiconductors has a new trade name - NXP Semicon-
ductors.

Flash Code Protection

Cypress products meet the specifications contained in their particular Cypress PSoC Data Sheets. Cypress believes that its
family of PSoC products is one of the most secure families of its kind on the market today, regardless of how they are used.
There may be methods, unknown to Cypress, that can breach the code protection features. Any of these methods, to our
knowledge, would be dishonest and possibly illegal. Neither Cypress nor any other semiconductor manufacturer can guaran-
tee the security of their code. Code protection does not mean that we are guaranteeing the product as "unbreakable."

Cypress is willing to work with the customer who is concerned about the integrity of their code. Code protection is constantly
evolving. We at Cypress are committed to continuously improving the code protection features of our products.
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1.1 Using the PLC Kit

Cypress’s Powerline Communication (PLC) solution makes it possible to transmit command and
control data over high-voltage and low-voltage powerlines. This solution is developed for low band-
width powerline communication.

The CY3275 low-voltage (LV) PLC development kit provides the capability to develop an application
on the Cypress CY8CPLC20 device that can transmit and receive data over low voltage (12 V to
24 V AC/DC) powerlines.

m Chapter 1 provides a brief overview of the Cypress PLC solution. It describes the contents of the
development kit and lists its special features.

Chapter 2 describes how to install and configure the PLC LV board.

Chapter 3 gives the functional overview and describes the operating procedure of the PLC LV
board. It provides a high-level hardware description of the board.

m The Appendix provides the schematics, layout, and bill of materials.

1.2 The Cypress PLC Solution

Powerlines are available everywhere in the world. This makes them one of the most widely available
communication media. The pervasiveness of powerlines also makes it difficult to predict their char-
acteristics and noise. Because of the variability of powerline quality, implementing robust communi-
cation over powerline has been an engineering challenge for years. With this in mind, the Cypress
PLC solution is designed to enable secure, reliable, and robust communication over powerlines. The
key features of the Cypress PLC solution are:

m An integrated powerline PHY modem with optimized amplifiers that work with rugged high and
low voltage powerlines

m Powerline optimized network protocol that supports bidirectional communication with acknowl-
edgement based signaling and multiple retries

m  Support for 8-bit packet CRC and 4-bit header CRC for error detection and data packet retrans-
mission

m Carrier Sense Multiple Access (CSMA) scheme that minimizes collisions between packet trans-
missions on the powerline

The Cypress PLC solution consists of three key elements, as shown in Figure 1-1.

m Powerline network protocol layer

m Physical layer FSK modem

m Power amplification and coupling circuits

CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C 5
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Figure 1-1. Cypress PLC Solution Block Diagram
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The powerline network protocol layer and the physical layer FSK modem are implemented on the
CY8CPLC20 chip. The CY3275 board contains the CY8CPLC20 device along with the power ampli-
fication and coupling circuit for communicating on low voltage (12 V-24 V AC/DC) powerlines. For a
detailed description of the circuit design parameters, see application note AN55427, Cypress Power-
line Communication Board Design Analysis.

The network protocol layer allows addressing of multiple nodes on the network. This enables point-
to-multipoint communication. The protocol layer also provides a defined packet structure for trans-
mitting data packets from one node to the other as well as error detection and packet retransmit
functions.

The chip also contains a PSoC® core in addition to the PLC core. The PSoC core includes configu-
rable blocks of analog and digital logic as well as programmable interconnects. This architecture
allows to create customized peripheral configurations that match the requirements of each individual
application. Additionally, a fast CPU, flash program memory, SRAM data memory, and configurable
I/Os are included.

Figure 1-2 shows a two node system level diagram. To evaluate this kit, follow the steps in the quick
start guide, which is provided in the kit.

Note To evaluate this kit, a second low voltage PLC kit is required. The compatible kits are CY3275
(this kit) and CY3273 Low Voltage PLC Evaluation Kit. For more information, visit hitp:/
www.cypress.com/go/CY3275 and http://www.cypress.com/go/CY3273.

CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C
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Figure 1-2. PLC System Level Block Diagram - Two Nodes
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1.3 Kit Contents

The CY3275 LV PLC Development Kit contains:
m CY3275 LV PLC development board

m CY3275 quick start guide

m CD-ROM containing:

Packet test software — PLC Control Panel application

o o o o o o o o g

a
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PLC Control Panel release notes

CY3275 release notes

CY8CPLC20 data sheet

CY3275 development kit user guide
CY3275 board Altium design project
CY3275 board schematics, layout, and BOM

Application note — Using CY8CPLCZ20 in Powerline Communication (PLC) Applications

PSoC Designer™
PSoC Programmer

12 V DC power supply

MiniProg1 to program the CY8CPLC20 device
25 jumper wires

LCD module

USB-I12C bridge

Retractable USB cable

Daisy chain cable

Five CY8CPLC20-28PVXI SSOP device samples
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Additional Learning Resources

Visit http://www.cypress.com/go/plc for additional learning resources in the form of data sheets, tech-
nical reference manuals, and application notes.

CY3275 Schematic.pdf: http://www.cypress.com/go/CY3275

CY3275 Board Layout.zip: http://www.cypress.com/go/CY3275

CY3275 Kit documentation: http://www.cypress.com/go/CY3275

For a list of PSoC Designer-related trainings, see http://www.cypress.com/?rID=40543
CY8CPLC20 data sheet: http://www.cypress.com/?rID=38201

For more information regarding PSoC Designer functionality and releases, refer to the user guide
and release notes on the PSoC Designer web page: http://www.cypress.com/go/psocdesigner
For more information regarding PSoC Programmer, supported hardware, and COM layer, go to
the PSoC Programmer web page: http://www.cypress.com/go/psocprogrammer

AN54416, Using CY8CPLC20 in Powerline Communication (PLC) Applications
http://www.cypress.com/?rID=37951

Document Revision History

Table 1-1. Revision History

PDF Creation | Origin of

Revision Date Change Description of Change
* 08/14/09 IUS Initial release.
*A 09/03/09 IUS Rework for external release.
*B 12/10/09 RARP Content updates
Added references to the compatible low voltage PLC kits. Added a ref-
G 08/04/11 FRE erence to the quick start guide for evaluation. Added clarifications to the

text throughout the document. Removed reference to CY3277 and
CY8CLED16P01. Updated section 1.4. Added Getting Started section.

Documentation Conventions

Table 1-2. Document Conventions for Guides

Convention Usage

Courier New

Displays file locations, user entered text, and source code:
C:\ ...cd\icc\

Italics

Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold]

Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open

Represents menu paths:
File > Open > New Project

Bold

Displays commands, menu paths, and icon names in procedures:
Click the File icon and then click Open.

Times New Roman

Displays an equation:
2+2=4

Text in gray boxes Describes Cautions or unique functionality of the product.

CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C
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This chapter describes how to install and configure the CY3275-LV PLC Development Kit.

2.1 Kit Installation

To install the kit software, follow these steps:

1. Insert the kit CD into the CD drive of your PC. The CD is designed to auto-run and the Kit Installer
Startup screen appears.

2. Click Install CY3275 Low Voltage PLC Kit to start the installation, as shown in Figure 2-1.
Figure 2-1. Kit Installer Startup Screen

S cy32751V PLC Development Kit

Pt
==/ CYPRESS

PERFORM

CY3275-LV PLC Development Kit

OpenC\"Sz?SUser =

Install C¥3275 Law Wolkage PLC Kit...
Install PLC Control Panel GUT...

® 2011 Cypress Semiconductor Corporation. All rights reserved

Note If auto-run does not execute, double-click the cyautorun.exe file on the root directory of the
CD, as shown in Figure 2-2.

CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C 9
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Figure 2-2. Root Directory of CD

Files Currently on the CD

5 I o RN o NN o BN oo NN o NN o N o =

C¥3275-LV  Documenta... Firmware Hardware Prerequisite  PSoC Designer PSoiC Softvare aukarun
PLZ Devel... Programmer
B = s
cyaukarun cyaukorun setup

3. The CY3275-LV PLC Development Kit InstallShield Wizard screen appears. Choose the folder

location to install the setup files. You can change the location of the folder using Change, as
shown in Figure 2-3.

4. Click Next to launch the kit installer.
Figure 2-3. CY3275-LV PLC Development Kit - InstallShield Wizard

CY3275-LV PLC Development Kit - InstallShield Wizard &|

Welcome to the InstallShield wizard for
CY3275-LY PLC Development Kit

The InztalShield 'Wizard will install Cv3275-Lv PLC
Development Kit on your computer. To continue, click
Mext.

Select folder where zetup will install files.

(i Ingtall Cv3275-LW PLC
el

C:AProgram FileshCypress

[ Mest> J[ Cancel ]

5. On the Product Installation Overview screen, select the installation type that best suits your

requirement. The drop-down menu has the options Typical, Complete, and Custom, as shown
in Figure 2-4.

6. Click Next to start the installation.

10 CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C
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Figure 2-4. Installation Type Options

* Cylnstaller for CY3275-LV PLC Development Kit 1.0

Product Installation Overview
Chaonse the install bwpe that best suits your needs

Choosze the bpe of installation
Product:
Cv3275-LY PLC Development Kit

Installation Tppe:

Installs the most common features of
Cv3275-LY PLC Development Kit

The following products need to be inztalled manually
Adobe Reader

(= (oo ) (v ]

7. When the installation begins, a list of all packages appears on the Installation page.

8. A green check mark appears adjacent to every package that is downloaded and installed, as
shown in Figure 2-5.

9. Wait until all the packages are downloaded and installed successfully.

Figure 2-5. Installation Page

* Cylnstaller for CY3275-LV PLC Development Kit 1.0

Installation Page
Flease wait while setup installs/configures Cv'3275-LY PLC Development Kit on your computer

Caching s
& PSoCPragrammers etup
w PSoCProgrammer3.13.0 961
ClockProgrammer1.3.0.961
USBBootioader. 561
BridgeControlPanel.3.0.961
ExamplzCode 961
Devicel atabase. 961
PSoCDesignerSetup
PSoCDesigner_CoreS. 1 2306.0 www.cypress.com/go/kits
FPSoCDesigner_Content5.1.2308.0 /
PSoCDesigner_Doch.1.2306.0 T

= | & . 6‘%

Skatug

[llllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllll‘

In a design jam?

- 5

10.Click Finish to complete the installation, as shown in Figure 2-6.

CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C 11
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Figure 2-6. Installation Completion Page

* Cylnstaller. for CY3275-LV PLC Development Kit 1.0

12 CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C



=
=#CvpREss

PERFORM

2.2 PSoC Designer

Getting Started

Click Start > All Programs > Cypress > PSoC Designer <version> > PSoC Designer <ver-

sion>.

2. Click File > New Project to create a new project on the PSoC Designer menu or go to File >
Open Project/Workspace to work with an existing project.

Figure 2-7. PSoC Designer Workspace
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3. For more details on PSoC Designer, go to Help Topics from the following directory:
<Install_Dir>:\Cypress\PSoC Designer\<version>\PSoC Designer 5\Help\

PSoCDesigner

(Compiled HTML Help file)

CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C 13
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2.3 PSoC Programmer

1. Click Start > All Programs > Cypress > PSoC Programmer <version> > PSoC Programmer
<versions.
2. Connect the MiniProg from Port Selection, as shown in Figure 2-8.

Figure 2-8. PSoC Programmer Workspace
@ PSoC Programmer L‘..JL@J%

File Load
Fi  vidw Opfics e ki L T
5 M Iy L
A= 1
] Port Selection 4lp | Programmer | Utiliies | JTAG
m. Programming Parameters
Eile Path: EABrisa_Cypress1\Data\Cr321 0-PSOCEVAL T Firmware\dSh_Example_LED_Logic\dSh_Example_LED_Logichex
Programmer: MIMIProg1/08215B0C3314
Prograrnming Mode: ) Reset @) Power Cycle Power Detect
Werification @ on O off Connectar; Sp 10p
||| AutoDetection: ® on O off Clock Speed: | 4 /1
Device Family
29466 v Frograrnmer Characteristics Status
= - Protcol  JTaG  @wD @ 1ssP  jzc | ExecufionTime: 860 seconds
peves ¥olsae: @ gy () 33y 25y (qpy | CouerSEls oM
CYBC2H4B6-24PA1 |w Woltage: & |
Actions Fesults {Ead
Power On at 1:14:10 PN MINIPragl/08215B0C331k |
Program Finished at
1:11:05 PH
Programming Succeeded
Doing Checksum
Doing Protect
Verify Succeeded
Verify Starting
Programming Succeeded
Programming Starting
Erase Succeeded
Device set to
CYBCZ9466-24PET at 32768 FLASH bytes
1:10:00 PH
Device Family set to
29x66 at 1:10:00 FM
Automatically Detected Device: CYSC29466-24FPXI 0

For Help, press FL

3. Click the File Load button to load the hex file.

4. Use the Program button to program the hex file on to the chip.

5. When the file is successfully programmed, ‘Programming Succeeded’ appears on the Actions
pane.

6. Close PSoC Programmer.

Note For more details on PSoC Programmer, go to Help Topics from the following path:

<Install_Dir>:\Cypress\Programmer\<version>\PSoC_Programmer Compiled HTML

Help file.
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2.4 Software Installation

2.4.1 Before You Begin

All Cypress software installations require administrator privileges; but this is not required to run the
installed software.
1. Shut down any Cypress software that is currently running.

2. Disconnect any Cypress devices (USB-12C bridge, ICE Cube, or MiniProg) from your computer.

2.4.2 Prerequisites

The PLC Control Panel GUI requires the latest versions of Microsoft .NET Framework, Adobe Acro-
bat Reader, and a Windows Installer. If your computer does not have .NET Framework and Windows
Installer, the installation automatically installs them. However, if your computer does not have Adobe
Acrobat Reader, download and install it from the Adobe website.

2.4.3 Installing PLC Control Panel Software

The PLC Control Panel GUI is installed as a prerequisite when you install the CY3275-LV PLC
Development kit. Follow the steps shown on the screen to complete the installation.

To reinstall this application, select Install PLC Control Panel GUI from the installation screen, as
shown in Figure 2-1.

Click Start > All Programs > Cypress > PLC Control Panel > PLC Control Panel.

The PLC Control Panel application controls the CY3275-LV PLC Development Kit over USB inter-
face from a PC. The application's startup display, when a board is attached and operating, is shown
in the following figure.
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Figure 2-9. PLC Control Panel Startup Display

PLC Control Panel
File  Window  Help

Main Menu lLocaINode Remote Node i ul;'l.essag.ji-ﬁg. ?f-N-o.i"se"N.I;aasuremen.ti
Connect USB-12C bridge
USB-12C bridges:

[PLC #0 HID USE to IIC converter 57M: 0000011 |

[Blink GRM LED | [ Connect |

USEI2C Options

&) +5¥ PWR ) EXT. PWR

PLC Slave Address

@ 0x01 ) 0x7A O Other |___|
12C Clock Rate

) 50 KHz ) 100 KHz (3) 400 KHz

PLC #0 Connected

After installing PLC Control Panel, refer to the required documentation at the following location:
B <CD Drive>:\Software\PLC Control Panel\PLC Control Panel Release Notes.pdf
B <CD Drive>:\Software\PLC Control Panel\User Guide for Cypress PLC Control Panel GUIl.pdf

The PLC Control Panel user guide is also available in the installation directory. It contains additional
information about installation and how to set up the kit to work with the GUI. It can also be accessed
from the Help menu in the PLC Control Panel GUI.
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This chapter explains the key features of the CY3275-LV development board.

3.1 Features

The Cypress CY3275-LV CY8CPLC20 development board is a versatile tool with the following fea-
tures:

m User friendly PLC Control Panel application available on the kit CD-ROM
m Chip power supply derived from 12 V to 24 V AC/DC

m CY8CPLC20-OCD chip — 100-pin TQFP on chip debug (OCD) device that allows quick design
and debug of PLC applications. The CY8CPLC20 100-pin TQFP is available for debug purposes
only. For production quantities, CYSCPLC20 is available in 28-pin SSOP and 48-pin QFN pack-
ages

User configurable general purpose LEDs

General purpose 8-position DIP switch

RJ-45 connector to use ICE debugger

RS-232 COM port for serial communication

Header to attach the LCD card

12C header for communicating to external devices
ISSP header for programming the CY8CPLC20 chip

3.2 PLC Development Board Functional Overview

The PLC development board is designed as a development platform for low bandwidth (up to
2400 bps) powerline communication applications.

The application on CY8CPLC20 generates the data. The PLC core encapsulates this data into a
PLC network packet. The FSK modem modulates this packet and the coupling circuitry incorporates
the resulting sinusoidal waveform onto the existing waveform on the low voltage bus.

3.2.1 Operating Conditions

m Input voltage: 12 V/24 V AC/DC

m Input current: 200 mA/150 mA

m Operating temperature: 0 °C to 40 °C

m Operating humidity condition: 5% to 95% RH, non-condensing

Note The board's ground reference is directly connected to the '—' input of the power. If the line volt-
age is AC, the same polarity should be maintained when connecting the boards (same as DC). This

will prevent any potential shorts that may occur if the polarities are swapped and the PLC kits are
connected to equipment that share the same ground reference (for example, a PC).

CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C 17
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Hardware Description

Figure 3-1 shows the programmable low voltage PLC development board. The key components and
areas are highlighted. This section provides a description of the user-accessible components and
how to use these components on the board. For a detailed description of the design parameters for
the PLC circuit, see application note AN55427, Cypress Powerline Communication Board Design
Analysis. The board is divided into seven main sections:

m Development

LCD module

Debugger

RS-232 COM port

Power supply

Transmit amplifier and receive filter
Low voltage coupling circuit

Figure 3-1. Top View of Cypress Programmable PLC LV Development Board

I’C Connector (J15)
and Jumpers
(JP1, JP3, JP4, JP5)

ISSP Programming
Connector (J21)

Reset Pushbutton
(1)

RJ-45 Debugger,
Connector (J14)

General Purpose LEDs
Connected to LED1-4

(43)

CY8CPLC20 PLC Device
With On-Chip Debugger (U1)

(J2)

Power Supply Breadboard with surrounding

GPIO headers

Transmit Filter, Transmit
Amplifier, and Receive Filter

Pushbutton (S4)
Connected to SW

Potentiometer (R47)
Connected to VR

DIP Switch (S3)
Connected to J12

PLC RX, TX, BIU Indicator  Potentiometer (R46) LCD Connector
LEDs (DS2, DS3, DS4) For LCD Contrast Connected to Port4

The core of the PLC LV board is the CY8CPLC20 chip. The communication signal flow on this LV
board is as follows:

Transmit. CY8CPLC20 TX pin (FSK_OUT) — Power Amplifier Circuitry — LV Coupling Circuitry —
LV Powerline (12 V to 24 V AC/DC).

Receive: LV Powerline (12 V to 24 V AC/DC) — LV Coupling Circuitry — Passive Low Pass Filtering
— Vdd/2 Biasing - CY8CPLC20 RX pin (FSK_IN).
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3.3.1 Development

3.3.1.1 User I/Os, Bread Board, and GPIO Headers

This section is the area where you create your custom design. All GPIO pins (excluding those
required for PLC communication) are routed to this bread board area. Some of the pins are shared
for other purposes (for example, the port 4 pins P4[6:0] are also connected to the LCD connector).

Header J18 has pins that are connected to user I/Os (potentiometer, pushbutton, and LEDs). In
Figure 3-2, these connections are represented by the green arrows. To connect one of the user 1/0Os
to a CY8CPLC20 pin, connect a jumper wire between the respective header pins. For example, to
connect the pushbutton S4 to pin P1[6], place a jumper wire in SW on header J18 and the other end
in P16 on header J9.

The DIP switch bank S3 is not connected directly to any of the CY8CPLC20 pins. The DIP switch is
connected to header J12, so that a jumper wire can be connected to any of the pins. The DIP switch
is active LOW (connected to GND when in the ON position).

Figure 3-2. Bread Board

General LEDs
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Free: P30-P37

Port1 Digital Port (J9)
12C: P17. P15
Free: P16, P12

Port5 Digital Port (J17)
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Port2 Digital Port (J16)
BIU LED: P21
RX LED: P23
TX LED: P25
Free: P26

Port0 Analog/Digital Port (J13)
Free: PO1, P02, P04, P07

Port4 Digital Port (J1)
LCD: P40-P46
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Push button (S4)

_epe s

TILLL
W AT Potentiometer (R47)

DIP Switch (S3) with
Header (J12)
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3.3.1.2  CY8CPLC20 Device

This section has the CY8CPLC20-OCD chip, which has the integrated transmit/receive modem, net-
work protocol, and application layer. It also has an 12C header for optional communication with an
external host processor. The ISSP header is provided to program the part. The part has a built-in
debug support using the RJ-45 connector, which can be used with the ICE debugger. It also has
three dedicated LEDs to indicate communication on the powerline: green LED for TX, red LED for
RX, and yellow LED for BIU.

Figure 3-3. CY8CPLC20 Device, I°C, and ISSP Headers

12C-SDA pull-up (JP4) I2C-SCL pull-up (JP3)
connects 12C SDA line to a connects 12C SCL line to a
pull-up resistor pull-up resistor

I12C Connector (J15)

Reset Jumper (JP5)
connects XRES to 12C Connector

5V PWR Jumper (JP1)
connects 5 V to 12C Connector

Reset Pushbutton (S2)

ISSP Programming Connector (J21)

CY8CPLC20 PLC Device with
On-Chip Debugger (U1)

Table 3-1. Headers and Jumpers

Headers and Jumpers Description
BIU LED[DS4] Yellow LED to indicate when the transmit frequency band is in use
CY8CPLC20-0OCD Cyp_ress powerline transceiver device. It is a 100-pin on-chip debugger (OCD)
device
J8 2-pin header for connecting to Vcc and Gnd

V —Vdd Pin: This pin can provide a maximum of 50 mA at 5 V to an external board
only when the input to the board is 12 V. For input voltages greater than 12 V, do
not use this pin to power another board. This pin is only to source the current. Do
not use this pin to power the CYSCPLC20 device. Note that the PWR jumper
(JP1) needs to be connected to enable this functionality

G — Gnd Pin: This pin can provide the ground reference to an external board

J15 D — 12C Data (SDA): Data line for the 12C communication. This pin is directly con-
nected to the CY8CPLC20 device

C —12C Clock (SCL): Clock line for the 12C communication. This pin is directly con-
nected to the CY8CPLC20 device

R — Reset: Connecting this pin to an external board enables the CY8CPLC20 chip
to be reset by an external board. Note that the RES jumper needs to be connected
to enable this functionality

JP1 (PWR) Connect this jumper to power an external board from the CY3275. The external
board is powered through the V and G pins on the 12C connector (J15)

20 CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C
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Headers and Jumpers

Description

JP3 (12C-SCL)

I12C SCL pull up jumper. While communicating through 12C(J15), one side should
pull up the line. When the jumper is connected, the SCL line is pulled high. This
needs to be done when the user wants the 12C link to be pulled up by the CY3275
board. This jumper does not need to be placed if the USB-I2C bridge is used to
communication with the host

JP4 (12C-SDA)

12C SDA pull up jumper. While communicating through 12C(J15), one side should
pull up the line. When the jumper is connected, the SDA line is pulled high. This
needs to be done when the user wants the 12C link to be pulled up by the CY3275
board. This jumper does not need to be placed if the USB-I2C bridge is used to
communication with the host

JP5 (Reset)

The jumper is to enable reset of the PLC chip through an external board. When
this jumper is connected, the external board reset can be connected to the R pin
on the 12C header (J15)

LED1-LED4

Headers connected to general purpose configurable LEDs

P01,P02,P04, PO7

Free analog/digital port pins

P21

Port pin connected to yellow LED for BIU

P23 Port pin connected to red LED for RX
P25 Port pin connected to green LED for TX
P26 Free port pin

P40-P46 Port pins connected to LCD card

P15 Port pin connected to 12C data line (SDA)
P16, P12 Free port pins

P17 Port pin connected to 12C clock line (SCL)
P30,P31,P32,P33,P34, Free port pins

P35, P36, P37

P47 Free port pin

P50,P51,P52,P53

Free port pins

PWR LED[DS1]

Blue LED that glows when the board is powered on

R46

Adjusting this potentiometer adjusts the contrast on the LCD daughter card

R47

This is a variable resistor (potentiometer) that connects to the VR header. It is used
to generate a voltage between +5 V and GND

RX LED[DSZ2]

Red LED to indicate when the board is receiving data

S2 Reset switch for the CY8CPLC20-OCD chip
These DIP switches are general purpose and can be routed to any port of the
S3[7-0] CY8CPLC20 chip. In the ON position, the switch is connected to ground. In the
OFF position, the signal is high-Z
SW Header connected to the switch S4. S4 is a general-purpose switch. Active HIGH

(connected to VDD when pressed)

TP1, TP2, TP3, TP4

Grounded test points to facilitate probing/debugging

TX LED[DS3]

Green LED to indicate when the board is transmitting data on to the powerline

VR

Header connected to the potentiometer R47

CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C 21
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Potentiometer and DIP Switches

The board has 8-position general purpose DIP switches (S3). A general-purpose potentiometer
(R47) is provided next to the DIP switches. This potentiometer can be routed to the chip using the
GPIO pins. The second potentiometer (R46) is specifically meant to control the contrast for the LCD
daughter card in the LCD1 slot.

LCD Daughter Card

This card is an LCD module easily connected to the board. It is connected and controlled by using
the CY8CPLC20 port 4 pins P4[6:0].

Figure 3-4. LCD Daughter Card
O_“’.'r ,,,,,

It is connected to the main board, as shown in Figure 3-4. The LCD contrast is controlled by the
potentiometer R46.

Figure 3-5. LCD Daughter Card Connection

L --www

Aninian Potentiometer R46
------- - for LCD Contrast

Debugger

The RJ-45 ICE-Cube emulation connector provides a debug interface between the CY8CPLC20-
OCD device and the ICE-Cube emulation tool using PSoC Designer. A CY3215-DK In-Circuit Emu-
lation Development Kit is required to interface the PC to this board. This kit is available for purchase
at: http://www.cypress.com/go/CY3215-DK.

CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C
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PLC LV Development Board

Figure 3-6. RJ-45 Connector

3.3.4 RS-232 COM Port

The RS-232 COM port is used with a standard RS-232 cable to connect two RS-232 capable
devices together. The RS-232 header (J20) is a 4-pin header that has connections for the RX, TX,
RTS, and CTS lines. These are wired to port pins to connect the device to the respective pins on the
RS-232 DB9 port.

Figure 3-7. RS-232 COM Port

The following table shows the controls associated with the RS-232 COM port.

Table 3-2. Key RS-232 COM Signals

Control

Description/Comment

RX

The board receives the RS-232 information through this pin

TX

The board transmits RS-232 information through this pin

RTS

The host asks the chip if it can send information through this pin

CTS

The chip signals that it is ready to accept information through RX

CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C
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3.3.5 Power Supply Circuit

This section takes the power from the powerline and generates 5-V DC voltage for the operation of
the PLC transceiver, transmit amplifier, and other components on the chip.

Table 3-3. Key Power Supply Circuitry Components

Component Description

J2 Connector for the wall wart, power adapter, and daisy chain cables

u2 5-V regulator
2-pin header to connect other boards in daisy chain and power them. The cable for this is pro-
vided with the kit. Connect a maximum of five boards in one daisy chain. It is important to main-

J3 tain the same polarity of the power for both DC and AC input voltages. The AC polarity must be
the same for all boards because the '-' power input terminal is connected directly to the ground
reference on the board

DS1 Blue LED, which is on when the board is powered

The key components are circled in the following schematic.

Figure 3-8. Power Supply Schematic

NBIG

MI20IISI01A

3.3.6 Transmit Amplifier and Receive Filter

The transmit signal from the FSK_OUT pin of the CY8CPLC20 device is amplified (to drive the sig-
nal on the powerline). The passive receive filter prepares the signal for the FSK_IN pin of the
CYBCPLC20 device.

Table 3-4. Key Transmit Amplifier Components

Component

Description

U3, Qt, Q2

These opamp and high-gain transistors are used for power amplification of the transmitted PLC
signal.

Q3

This transistor controls whether the transmit circuit is enabled or is in a high-Z state. Its input is
the TX_DISABLE signal from the PLC device.
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The key components are circled in the following schematic.

Figure 3-9. Transmit Filter, Transmit Amplifier, and Receive Filter

CRX

THDSABLE

3.3.7 Low Voltage Coupling Circuit

This circuit couples the signal from the board on to the powerline. On the receive side, the same cir-
cuit couples the carrier from the powerline into the board, while filtering out the power and low fre-
quency content on the powerline.

Table 3-5. Key Transmit and Receive Coupling Components

Component Description
This inductor blocks high frequency signals (for example, FM radio) from entering the receiver.
L1 . X -
It also offsets the impedance of capacitor C30 to have a lower transmit impedance.
Lo This inductor, along with C1, filters out low frequency signals (for example, power) and pres-
ents a high impedance to the 132 kHz PLC signal.
This is the coupling capacitor that couples the PLC signal and blocks the low frequency sig-
C1 f . .
nals. Its voltage rating must be higher than the voltage on the powerline.

The key components are circled in the following schematic.

CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C 25
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Figure 3-10. Coupling Circuit
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Code Example

The CY3275 kit is designed for systems that require a communication interface over commercial
low-voltage powerlines. The CY8CPLC20 device combines the robustness and ease-of-use of the
PLC solution with the configurability and flexibility of the PSoC core. The CY8CPLC20 device pro-
vides the ability to run your own application. The PLT User Module manages the network protocol
and the physical layer FSK modem, which transmits and receives messages over the powerline. For
more information on this user module, see AN54416, Using CY8CPLC20 in Powerline Communica-
tion (PLC) Applications.

Technical Reference

For a real-time list of knowledge base articles for the CY3275 kit, refer to the Online Knowledge
Base.

For help with the installation of the control panel, see the Control Panel User Guide provided in the
kit CD. You can also download the latest revision of the GUI setup and user guide from http://
www.cypress.com/go/plc.

CY3275 Cypress Low Voltage Programmable PLC Development Kit Guide, Doc. # 001-53657 Rev. *C
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A. Appendix

A.1 Schematics

A.1.1 Board Overview

U_1-PLC20_Tnterface

PLCA0 Imterface SchDoc
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U 2 INFILTERS
2-LVFILTERS Schloc

THDISABLE [

RYX |

U 3-LVOOUPLING
3-LVCOUPLING. SchDoe

] vsIG
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A13 Transmit and Receive Filter Coupling
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A3 Bill of Materials

Description Designator Qty. Value Manufacturer Mfr. Part No.
f;ggc't” Ceramic 0.47UF 50V X7R 10% | g 1 |o47uF  |TDK C3216X7R1H474K
Capacitor 1T00UF 10V ALUM LYTIC RADIAL|C2 1 | 100uF PANASONIC ECA-1AM101
Capacitor Electrolytic 220uF 50V C3 1 | 220uF PANASONIC ECA-1HM221
Capacitor Ceramic 0.1uF 25V X7R 0603 C4,C7,C9 3 |0.1uF AVX 06033C104JAT2A
Oogggc”or Ceramic 0.01uF 25V C0G 5% | o5 1 |0.01uF  |TDK C1608C0G1E103J
Capacitor Ceramic 1.0uF 16V X7R 0603 C6, C35 2 |1uF Murata GRM188R71C105KA12D
Capacitor Ceramic 1UF 50V Y5V 0805 Cc8 1 |1.0uF Murata GRM21BF51H105ZA12L
Capacitor Ceramic 0.01uF 25V X7R 0603 | C26, C34 2 |0.01uF AVX 06033C103JAT2A
Capacitor 1.0uF, 16V ca27 1 [1.0uFR16V
Capacitor 0.1uF, 16V c28 1 [0.1uF16V
Capacitor 0.47uF, 16V C29, C30, C31 3 |0.47uF,16V
Capacitor Ceramic 22pF 100V C0G 0603 C32,C33 2 |22pF Murata GRM1885C2A220JA01D
Capacitor Ceramic 0.1uF 25V X7R 0603 C36 1 |0.1uF AVX 06033C104JAT2A
Capacitor 0.1uF C37,C38 2 |0.1uF
Capacitor 10uF,10V C39 1 |10uF,10V | Vishay 293D106X9010A2TE3
Capacitor 100pF C41 1 | 100pF
Diode Super Fast 100V 1A D1 1 Diodes Inc. ES1B-13-F
Diode TVS 33V 600W BI-DIR SMB D2 1 Littelfuse SMBJ33CA
Diode Schottky 40V 0.3A SOT-23 D3 1 ST Micro BAT54SFILM
Diode Ultrafast 100V 1A D4, D5 2 Diodes Inc. ES1B
Blue LED DSH 1 |Blue SML-E12BC7TT86
LED Red Clear 0805 DS2 1 Lite-On LTST-C170KRKT
LED Green Clear 0805 DS3 1 Lite-On LTST-C170KGKT
LED Yellow Clear 0805 DS4 1 Lite-On LTST-C170KSKT
3M solderless breadboard super strip H1 1 Parallax 700-00012
Header, 10-Pin J1,J10, J12,J18 4 110
Power connector J2 1 CUl Inc PJ-102A
Power Header, 2-Pin J3 1 MOLEX 09-65-2028
Header, 4-Pin J9, J13, J17, J20 4 |4
ICE Connection J14 1 Tyco 5557785-1
ISSP Conn J15 1
Header, 4-Pin J16 1 |4
Female DB-9 J19 1 |DB9-F
ISSP Conn J21 1
(DO NOT POPULATE) Power Connector Jo2
Jack 2.1mm PCB
(DO NOT POPULATE) Right Angle 2X13
header 0.1" Spacing J23
Header, 2-Pin, Male JP1,JP3,JP4, JP5 | 4 |2 S:;‘:”C Compo-
Ferrite Chip 100 OHM 4A 0805 L1 1 TDK MPZ2012S101A
Inductor PWR UNSHIELD 470UH SMD L2, L3 2 |470uH Pulse P0752.474NLT
14-Pin header, Female LCD1 1 |14 3M/ESD 929850-01-36-RA
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Description Designator Qty. Value Manufacturer Mfr. Part No.

Red LED tggl LED2, LEDS, 4 |Red SML-LXT0805IW-TR
Mounting Holes m¥g; m¥gi 4
Transistor NPN 45V 3A Q1 1 Zetex ZXT690BKTC
Transistor PNP 40V 3A Q2 1 Zetex ZXT790AKTC
Transistor NPN SOT-23 Q3 1 Fairchild MMBT3904LT1
Resistor 402 OHM 1/10W 1% 0603 SMD R1 1 |402 Rohm MCRO3EZPFX4020
Resistor 10 OHM 1W 5% METAL OXIDE R2 1 13V0hm, Stackpole RSMF 110 5% R
Resistor 240 OHM 1/10W 1% 0603 SMD R3 1 240 Rohm MCRO3EZPFX2400
Resistor 715 OHM 1/10W 1% 0603 SMD R4 1 |715 Rohm MCRO3EZPFX7150
Resistor 0.0 OHM 1/10W 5% 0603 SMD R5 110 Rohm MCRO3EZPJ000
Resistor 10.0k 1% 1/10W 0603 :?GRI;EQR?;?:QO 8 [10.0K Rohm MCRO3EZPFX1002
Resistor 100 OHM 1/10W 1% 0603 SMD R7 1 100 Rohm MCRO3EZPFX1000
Resistor 620 OHM 1/10W 1% 0603 SMD R10, R11 2 |620 Rohm MCRO3EZPFX6200
Resistor 0.5 1% 1/4W 0805 R13, R17 2 |0.51/4W | Susumu RL1220S-R50-F
Resistor 1.00k 1% 1/10W 0603 R14, R23, R24 3 |1.00k Yageo RC0603FR-071KL
Resistor 4.99 1% 1/10W 0603 R15 1 14.99 Yageo RCO0603FR-074R99L
Resistor 4.70K OHM 1/10W 1% 0603 SMD | R21 1 [4.7K Yageo RCO0603FR-074K7L
Resistor 330 Ohm 1% 1/10W 0603 R22 1 330 Rohm MCRO3EZPFX3300
Potentiometer R46, R47 2 Bourns Inc 3352T-1-103LF

R48, R49, R50,
Resistor 1.0K, SMT R51, R61, R62, 9 1K Panasonic ERJ-6GEYJ102V

R63, R64, R65
Resistor 7.50k 1% 1/10W 0603 R52, R53 2 |7.50K Rohm MCRO3EZPFX7501
Resistor 2.10k 1% 1/10W 0603 R54 1 |2.10K Rohm MCRO3EZPFX2101
Resistor 56 Ohm, SMT R57, R58, R59, R60| 4 |56
Swtich, SPST S1, 54 2 Omron B3F-1022
4009 Series DIP Switch, Raised actuator S3 1 ESwitch KAJOBLAGT
Simple Test point TP1, TP2, TP3, TP4| 4
Simple Test point TP5 1
Simple Test point TP6 1
CY8CPLC20 OCD Part U1 1 Cypress CY8CPLC20-OCD
Voltage Regulator 5 Volt u2 1 ST Micro LM317MTG
Op-Amp 190MHz U3 1 National Semi- 1| \i6639MF/NOPB

conductor

RS-232 tranceiver (1.0uF Caps) us 1 MAX3232ECDR
Oscillator Y1 1 |24.00 MHz | Crystek C3290-24.000

Y1 (2nd source) Citizen CSX750FCC24.000M-UT
Crystal 32.768kHz 12.5pF Y2 1 |32.768kHz | ECS Inc. ECS-3X8X
LCD Module LCD1 1 Cypress Semi- | 4447 60003

conductor
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